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1 Introduction

The Nordic Thingy:91™ is a battery-operated prototyping platform for cellular IoT, certified for global
operation. It is ideal for rapid development of prototypes for cellular IoT systems and is especially suited
for asset tracking applications and environmental monitoring.

Nordic Thingy:91 includes a set of sensors to gather data about its own movements and the surrounding
environment. Temperature, humidity, air quality, air pressure, color, and light data can easily be extracted
for local or remote analysis. For input, the Nordic Thingy:91 offers a user-programmable button. Visual
output is achieved with user-programmable RGB LEDs, while a buzzer can provide audible output. The
standard application firmware on Nordic Thingy:91 extracts the data from the different sensors and relays
it securely to the nRF Connect for Cloud, where it is displayed in a user-friendly interface. The LEDs can be
controlled remotely through the same interface.

The firmware supports concurrent operation with LTE Link Monitor, a tool providing an AT command
interface enabling link and network testing. The firmware has been developed using the nRF Connect
Software Development Kit (SDK). It is open source and can be leveraged and modified to suit your specific
needs. The firmware can be updated and debugged by using an external programmer/debugger, for
example with the one on the nRF9160 DK (Development Kit).

Nordic Thingy:91 integrates the nRF9160 System in Package (SiP), supporting LTE-M, NB-IoT and Global
Positioning System (GPS), and the nRF52840 System on Chip (SoC), supporting Bluetooth® Low Energy
and Near Field Communication (NFC). Source code for firmware, hardware layout, and schematics are all
available for free.

Nordic Thingy:91 has an antenna supporting GPS, LTE-M, and NB-IoT that enables it to support a global
range of LTE bands. It has two antennas connected to the nRF52840: a 2.4 GHz antenna for Bluetooth LE
and an NFC antenna. To connect to cellular network out of the box, Nordic Thingy:91 has a nano/4FF SIM
card slot and is bundled with an eSIM card from iBasis that comes preloaded with 10 MB.

A 1400 mAh rechargeable Li-Po battery is also part of this prototyping platform giving a smooth transition
into prototype field-testing.

Key features of Nordic Thingy:91
• 700-960 MHz + 1710-2200 MHz LTE band support1

• Certifications: CE, FCC
• LTE-M/NB-IoT/GPS, Bluetooth LE and NFC antennas
• Nano/4FF Subscriber Identity Module (SIM) card slot
• User-programmable button and RGB LEDs
• Environmental sensor for temperature, humidity, air quality, and air pressure
• Color and light sensor
• Low-power and high-G accelerometer
• Buzzer
• 4 x N-MOS transistor for external DC motors or LEDs
• Rechargeable Li-Po battery with 1400 mAh capacity
• Charging through USB
• PC connection through USB

1 The application currently enables the following frequency bands: 2, 3, 4, 8, 12, 13, 20, and 28
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nRF9160
• Multimode LTE-M/NB-IoT modem

• GCF certified for global operation
• 23 dBm output power
• GPS
• Power saving features: DRX, eDRX, PSM
• Coverage enhancement modes
• Single pin 50 Ω antenna interface
• Universal Integrated Circuit Card (UICC) interface

• Application processor

• 64 MHz ARM® Cortex®-M33 CPU
• ARM TrustZone® for trusted execution
• ARM CryptoCell 310 for application layer security
• 1 MB flash and 256 kB RAM
• 4 x SPI/UART/TWI, PDM, I2S, PWM, ADC

nRF52840 WLCSP
• Bluetooth LE and NFC support
• 64 MHz ARM Cortex-M4F CPU
• 1 MB flash and 256 kB RAM
• USB

The battery in this product cannot be easily replaced by users themselves. Batteries should be removed
only by qualified professionals due to safety concerns.
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2 Kit content

The Nordic Thingy:91 kit consists of hardware and access to software components, hardware design files,
applications, and documentation.

Figure 1: Nordic Thingy:91 hardware content

2.1 Downloadable content
The Nordic Thingy:91 prototyping platform includes firmware source code, documentation, hardware
schematics, and layout files.

Firmware
• Application firmware for Nordic Thingy:91

• Precompiled HEX files
• nRF52840 USB to UART bridge
• nRF9160 modem firmware
• nRF Connect SDK

PC tools
• nRF Connect for Desktop
• SEGGER Embedded Studio (SES)
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Kit content

Web applications
• nRF Connect for Cloud

Hardware files
The hardware files can be downloaded from the Nordic Thingy:91 product page.

The zip file and its subdirectories contain the hardware design files for the Nordic Thingy:91. The hardware
files for the circuit board are available in the following folder in the hardware files zip package:

\Thingy91 - Hardware files x_x_x\PCA20035-Thingy91 Board x_x_x

In this folder, you can find the following hardware design files:

• Altium Designer files
• Schematics and PCB layout files in PDF format
• Bill of materials
• Production files:

• Drill files
• Assembly drawings
• Gerber files
• Pick-and-place files

2.2 Related documentation
In addition to the information in this document, you may need to consult other Nordic documents.

• nRF9160 Product Specification
• nRF52840 Product Specification
• nRF9160 DK
• nRF52840 Development Kit
• nRF9160 Errata
• nRF52840 Errata
• nRF Connect SDK documentation
• nRF Connect for Cloud
• LTE Link Monitor
• nRF91 AT Commands Reference Guide
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3 Getting started

Setting up Nordic Thingy:91 requires completing the following steps.

Before you start:

• Unpack Nordic Thingy:91.
• Make sure you have an nRF Connect for Cloud account and sign in to nRF Connect for Cloud.

Once you are signed in, perform the following steps.

1. Add new LTE device.

2. Verify and activate the SIM card.

Input SIM ICCID and Personal Unblocking Key (PUK) from the SIM card, and add personal information.

3. Gently remove the rubber overlay to reveal the power switch and the top of Nordic Thingy:91. Insert
the SIM card.

4418_1336 v1.0 9
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4. Once the SIM card is inserted, power on Nordic Thingy:91. You will find the power switch next to the
micro-USB port.

Wait for orange breathing in the user-programmable LED.
5. Associate the Nordic Thingy:91 to your user account.

Enter the IMEI and PIN information that is found on the sticker on the Nordic Thingy:91 PCB. Wait for
cyan breathing which means that your Nordic Thingy:91 is associated and connected.

6. To activate GPS, go outdoors and press the button for a minimum of 10 s until the user-programmable
LED begins breathing purple.

• Purple breathing: GPS is active and searching
• Green breathing: GPS has fix

Wait for green breathing in the user-programmable LED which indicates that your Nordic Thingy:91 has
GPS fix.

Check that the position data is sent to nRF Connect for Cloud.

3.1 Connecting LTE link monitor
Install and open nRF Connect for Desktop. For instructions, see LTE Link Monitor. To download the latest
version, go to the nRF Connect for Desktop product page.

1. Install and launch LTE Link Monitor.
2. In the bottom-right corner, uncheck the Auto device/port filter option.
3. Connect your Nordic Thingy:91 to your computer using USB. Make sure it is powered on and select the

device.
To verify the connection, send AT and observe that the modem responds with OK.
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All asset tracker debug output shows up in the terminal view, and you can send AT commands to
the modem to try out different settings. For further details on available AT commands, see nRF91 AT
Commands Reference Guide.
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4 Managing Thingy:91 devices

You can add, remove, connect or disconnect Nordic Thingy:91 devices, and update firmware using nRF
Connect for Cloud.

For more information on how to manage devices in nRF Connect for Cloud, see Devices in nRF Connect for
Cloud.

Firmware updates for modem firmware, application firmware, and the firmware on nRF52840 are
described in Updating modem firmware on page 12, Updating application firmware on page 12,
and Updating firmware on nRF52840 on page 13. Make sure nrfjprog is installed before proceeding
with the firmware updates.

4.1 Updating modem firmware
To update the modem firmware, complete the steps in this section.

1. Download the latest modem firmware zip file.
You can find it under the Compatible Downloads tab that is halfway down the nRF9160 product page.

2. Connect Nordic Thingy:91 to the Debug out port on the nRF91 DK board using a 10-pin JTAG cable.

Note:  If using nRF91 DK as debugger, make sure VDD_IO is set to 1.8 V.

3. Power on both devices.
4. Start nRF Connect Programmer.
5. Connect to the available serial port.
6. Run Erase All on the device.
7. Run Update Modem and choose the zip file with the latest modem release.
8. Click Write.

4.2 Updating application firmware
To update the application firmware, complete the steps in this section.

1. Set the Nordic Thingy:91 SWD selection switch to nRF91.
2. Connect a 10-pin external debugger, for example nRF9160 DK or J-Link device supporting ARM Cortex-

M33.

Note:  If using nRF91 DK as debugger, make sure VDD_IO is set to 1.8 V.

3. Make sure Nordic Thingy:91 is powered on.
4. Flash the application firmware using Programmer in nRF Connect for Desktop or the following

command:

nrfjprog -f nrf91 --program <hex> --sectorerase -r
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4.3 Updating firmware on nRF52840
To update the firmware on nRF52840, complete the steps in this section.

1. Put the Nordic Thingy:91 SWD selection switch to nRF52.
2. Connect a 10-pin external debugger, for example nRF9160 DK or J-Link device supporting ARM Cortex-

M4.

Note:  If using nRF91 DK as debugger, make sure VDD_IO is set to 1.8 V.

3. Make sure Nordic Thingy:91 is powered on.
4. Flash the nRF52840 firmware using Programmer in nRF Connect for Desktop or the following

command:

nrfjprog -f nrf52 --program <hex> --sectorerase -r
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5 Hardware description

This chapter focuses on the hardware components of Nordic Thingy:91 with detailed descriptions of the
various hardware blocks that are present on the device.

The sensors available in Nordic Thingy:91 are not calibrated in production. Nordic Semiconductor does
not specify the accuracy of measurements. Users who want to reuse parts of this design to create
measurement devices should conform to documentation of the specific sensors.

5.1 Block diagram
The block diagram represents interactions between hardware components on Nordic Thingy:91.

USB Power switch

PMIC nRF9160

GPS LNA

Power switchBattery

SWD selectDebug in

Current 
measurement

Accelerometers

Environmental 
sensor

SIM card

NMOS 
transistors

LEDs

RF switches/
matching 
network

LED driver

Color sensor

Buzzer

Buzzer driver

nRF52840

Current 
measurement

Spare GPIO 
connector

Button

Matching 
network

Button

NFC antenna

RF

1.8 V3.3 V

Antenna

Antenna

Figure 2: Nordic Thingy:91 hardware block diagram

5.2 Hardware figures
The hardware figures show elements on both sides of the Nordic Thingy:91 PCB.
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Figure 3: Nordic Thingy:91 PCB, top

Figure 4: Nordic Thingy:91 PCB, bottom

5.3 nRF9160
The nRF9160 is the main MCU of Nordic Thingy:91. It is a compact, highly integrated SiP that makes the
latest low-power LTE technology, and advanced processing and security, accessible and easy to use for a
wide range of single-device low-power cellular IoT (cIoT) designs.

For more information on the SiP, see nRF9160 Product Specification.
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Figure 5: nRF9160 schematic

5.3.1 Antenna tuning
To improve antenna efficiency, especially in the sub-GHz LTE bands, Nordic Thingy:91 has dynamic antenna
tuning.

Different tuning components are used for different frequencies. This is achieved by using tuning
components between two SP8T RF switches. The switches are automatically controlled by the nRF9160
LTE modem and set to the correct state based on the frequency of operation. Six paths are used for LTE
frequency, and one path is used for GPS frequency.

RF_SW3 RF_SW2 RF_SW1 State Band Frequency

0 0 0 RF2 - RFC Not used Not used

0 0 1 RF7 - RFC 13U/D, 28D 746 MHz - 803 MHz

0 1 0 RF5 - RFC 12U/D, 17U/D, 28U

1U/D, 2U/D, 3U/D, 4U/D,
25U/D

698 MHz - 748 MHz

1710 MHz - 2200 MHz

0 1 1 RF3 - RFC 5D, 20U, 26D 824 MHz - 894 MHz

1 0 0 RF1 - RFC 8U/D 880 MHz - 960 MHz

1 0 1 RF8 - RFC 5U, 20D, 26U 791 MHz - 849 MHz

1 1 0 RF6 - RFC Not used Not used

1 1 1 RF4 - RFC GPS 1574 MHz - 1577 MHz

Table 1: Antenna tuning bands
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Figure 6: Antenna tuning circuitry schematic

5.3.2 RF measurements
The LTE signals are propagated through a coaxial connector. This makes it possible to perform conducted
measurements or attach external antennas.

By default, when no cable is attached, the RF signal is routed to the onboard antenna. When connecting
the adapter, the internal switch in the SWF connector will disconnect the onboard antenna and connect
the RF signal from the nRF9160 to the adapter.

The connector is of SWF type (Murata part no. MM8130-2600) with an internal switch. An adapter
is available (Murata part no. MXHS83QE3000) with a standard SMA connection on the other end for
connecting instruments. The adapter is not included in the kit. The insertion loss in the adapter cable is
approximately 0.5–1 dB.

Figure 7: Connecting a spectrum analyzer

5.3.3 GPS
The nRF9160 has a dedicated GPS port to support global navigation, and the same antenna is used for
both LTE and GPS. The GPS signal is RX only, and there is a low-noise amplifier (LNA) that amplifies the
signal before it is fed to the GPS RF port on the nRF9160.

The GPS signals are propagated through a coaxial connector located between the antenna and the
LNA. This makes it possible to attach external antennas. The connector is of SWF type (Murata part no.
MM8130-2600) with an internal switch. An adapter is available (Murata part no. MXHS83QE3000) with a
standard SMA connection on the other end for connecting instruments. The adapter is not included in the
kit. The insertion loss in the adapter cable is approximately 0.5–1 dB.
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Figure 8: External GPS antenna connector

The LNA enable signal is controlled by the logic circuitry. It is enabled only when the antenna tuning
circuitry is set to operate at the GPS frequency band. The LNA makes the GPS receiver more sensitive to
GPS signals and less sensitive to interference from other sources nearby.

Figure 9: GPS circuit schematic

Note:  GPS signals do not usually penetrate ceilings or other structures. For best GPS performance,
Nordic Thingy:91 should be used outside in an open space, far from sources of interference and
other structures that may block the signals.

5.3.4 SIM card
Nordic Thingy:91 is equipped with a nano-SIM (4FF) card slot.
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Figure 10: SIM card schematic

5.4 nRF52840
For USB, Bluetooth, and NFC connectivity, Nordic Thingy:91 uses a nRF52840 SoC. It is a powerful, highly
flexible, ultra-low power SoC that incorporates a Bluetooth Low Energy radio and a 32-bit ARM Cortex-
M4F CPU.

For more information on the SiP, see nRF52840 Product Specification.

Figure 11: nRF52840 schematic

5.4.1 NFC
Nordic Thingy:91 supports an NFC tag. NFC-A listen mode operation is supported on the nRF52840 SoC.

The NFC antenna input is available on connector J5.
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Figure 12: NFC antenna connector

NFC uses two pins, F1 (NFC1) and E2 (NFC2), to connect the antenna. These pins are shared with GPIOs
(P0.09 and P0.10), and the PROTECT field in the NFCPINS register in UICR defines the usage of these
pins and their protection level against abnormal voltages. The content of the NFCPINS register is reloaded
at every reset.

Note:  The NFC pins are enabled by default.

The NFC can be disabled and the GPIOs enabled by defining the CONFIG_NFCT_PINS_AS_GPIOS variable in
the project settings. The way of doing this depends on the Integrated Development Environment (IDE) or
toolchain in use.

• When using SEGGER Embedded Studio, go to Project > Edit Options > Code > Preprocessor >
Preprocessor Definitions and add the CONFIG_NFCT_PINS_AS_GPIOS variable.

• When using Keil, go to Project > Options for Target > C/C++ > Preprocessor Symbols > Define and add
the CONFIG_NFCT_PINS_AS_GPIOS variable.

5.4.2 USB
The Nordic Thingy:91 USB connector is connected to the USB interface of the nRF52840 SoC. This enables
PC communication and battery charging.

5.5 Pin maps
The pin assignments for the nRF9160 SiP and nRF52840 SoC are listed in the pin map tables.

I/O Label Description

P0.00 SENSE_LED_RED Red color of the color sensor support LED

P0.01 SENSE_LED_GREEN Green color of the color sensor support LED

P0.02 SENSE_LED_BLUE Blue color of the color sensor support LED

P0.03 SCK SPI clock line

P0.04 MOSI SPI master output, slave input data line

P0.05 MISO SPI master input, slave output data line

P0.06 ADXL372_INT1 High-G accelerometer interrupt line

P0.07 ADXL372_CS High-G accelerometer chip select line
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I/O Label Description

P0.08 ADXL362_CS Low-power accelerometer chip select line

P0.09 ADXL362_INT1 Low-power accelerometer interrupt line

P0.10 ADXL3x2_INT2 Accelerometer interrupt line 2, selectable by solder
bridge

P0.11 SDA I2C data line

P0.12 SCL I2C clock line

P0.13 N-MOS_1 Gate of N-MOS transistor externally available

P0.14 N-MOS_2 Gate of N-MOS transistor externally available

P0.15 N-MOS_3 Gate of N-MOS transistor externally available

P0.16 N-MOS_4 Gate of N-MOS transistor externally available

P0.17 ADP_INT PMIC interrupt line

P0.18 MCU_IF0 nRF52840 interface

P0.19 MCU_IF1 nRF52840 interface

P0.20 MCU_IF2 nRF52840 interface

P0.21 MCU_IF3 nRF52840 interface

P0.22 MCU_IF4 nRF52840 interface

P0.23 MCU_IF5 nRF52840 interface

P0.24 MCU_IF6 nRF52840 interface

P0.25 MCU_IF7 nRF52840 interface

P0.26 BUTTON Button input

P0.27 BH_INT Color sensor interrupt line

P0.28 BUZZER Buzzer PWM signal

P0.29 LIGHTWELL_RED Red color of the lightwell LEDs

P0.30 LIGHTWELL_GREEN Green color of the lightwell LEDs

P0.31 LIGHTWELL_BLUE Blue color of the lightwell LEDs

Table 2: nRF9160 pin map
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I/O Label Description

P0.00 XL1 Low frequency crystal

P0.01 XL2 Low frequency crystal

P0.02 N.A. Not used

P0.03 SPARE7 Analog/digital GPIO externally available

P0.04 N.A. Not used

P0.05 SPARE2 Analog/digital GPIO externally available

P0.06 SPARE1 Digital GPIO externally available

P0.07 N.A. Not used

P0.08 N.A. Not used

P0.09 NFC1 Near field communication antenna

P0.10 NFC2 Near field communication antenna

P0.11 MCU_IF0 nRF9160 interface

P0.12 N.A. Not used

P0.13 N.A. Not used

P0.14 IF_SWD_IO nRF9160 SWD interface data line

P0.15 MCU_IF1 nRF9160 interface

P0.16 N.A. Not used

P0.17 IF_SWD_CTRL nRF9160 SWD interface control

P0.18 RESET nRF52840 reset line, available on test point

P0.19 MCU_IF6 nRF9160 interface

P0.20 MCU_IF2 nRF9160 interface

P0.21 MCU_IF3 nRF9160 interface

P0.22 MCU_IF7 nRF9160 interface

P0.23 N.A. Not used

P0.24 N.A. Not used

P0.25 MCU_IF5 nRF9160 interface

P0.26 SPARE3 Digital GPIO externally available

P0.27 SPARE4 Digital GPIO externally available

P0.28 SPARE5 Digital GPIO externally available

P0.29 N.A. Not used

P0.30 SPARE6 Analog/digital GPIO externally available

P0.31 N.A. Not used

P1.00 MCU_IF4 nRF9160 interface

P1.01 COEX2 nRF9160 COEX interface
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I/O Label Description

P1.02 N.A. Not used

P1.03 N.A. Not used

P1.04 COEX1 nRF9160 COEX interface

P1.05 IF_SWK_CLK nRF9160 SWD interface clock line

P1.06 N.A. Not used

P1.07 COEX0 nRF9160 COEX interface

P1.08 SDA I2C data line

P1.09 SCL I2C clock line

P1.10 N.A. Not used

P1.11 SPARE8 Digital GPIO externally available

P1.12 N.A. Not used

P1.13 BOOT Boot button

P1.14 N.A. Not used

P1.15 N.A. Not used

Table 3: nRF52840 pin map

5.6 Motion sensors
Nordic Thingy:91 includes a low-power accelerometer and a high-G accelerometer.
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Figure 13: Low-power and high-G accelerometers schematic

When Nordic Thingy:91 is in low-power sleep mode, any user interaction will be detected by the low-
power accelerometer which will then wake up the device. The accelerometer has an SPI interface and
it can detect motion on three axes. By default, the INT2 line of the accelerometer is not connected to
nRF9160. If you want to use the INT2 line, solder SB6.

For detecting shocks, Nordic Thingy:91 uses a high-G accelerometer. The accelerometer has an SPI
interface, and it can detect motion on three axes. By default, the INT2 line of the accelerometer is not
connected to nRF9160. If you want to use the INT2 line, solder SB5.

Figure 14: Low-power accelerometer and high-G accelerometer interrupt line 2 selection
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5.7 Environment sensors
To monitor its surroundings, Nordic Thingy:91 has a multi-sensor chip that contains several sensors for
detecting different environmental properties and a separate color and light sensor.

The multi-sensor chip contains sensors for temperature, humidity, air quality, and air pressure.

Figure 15: Environment sensor schematic

The color sensor onboard Nordic Thingy:91 senses red, green, and blue light. The sensor faces towards the
blue transparent bottom case with light pipes guiding the light towards the sensor. To measure the color
on a surface, the color sensor is accompanied with an RGB LED that can illuminate the surface enabling
the color sensor to read the color of the reflected light. The color sensor is accessed through I2C (slave
address 0x38).

Figure 16: Color sensor schematic

5.8 Buzzer
For audio output, Nordic Thingy:91 has a magnetic buzzer. The buzzer is driven by a transistor using a
PWM input.

Figure 17: Buzzer schematic
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5.9 LEDs and buttons
Nordic Thingy:91 user interface consists of RGB LEDs and two buttons.

5.9.1 RGB LED
Nordic Thingy:91 is equipped with three RGB LEDs.

Two of the LEDs are used to light up the light well and are controlled by the same signals using transistors
as switches. The third LED is located near the color sensor and is used as auxiliary light for color
measurements.

Figure 18: LED schematic

5.9.2 Buttons
Nordic Thingy:91 has two buttons. The one located underneath the Nordic Semiconductor logo is
connected to the nRF9160 and used for user input. The second button is connected to the nRF52840 and
can be used to activate serial recovery mode of the nRF52840. The button is accessible only when the
rubber cover is removed.

Figure 19: Button schematic

5.10 Power supply
The main power source is a rechargeable lithium polymer (Li-Po) battery. The battery has a nominal
capacity of 1400 mAh and can be recharged through USB.

Nordic Thingy:91 has a power switch that physically disconnects the battery and the USB power from the
rest of the circuits. This switch must be on for Nordic Thingy:91 to work and charge the battery. When the
power switch is in the OFF position, it activates a circuit that drains the 1.8 V power domain.
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Figure 20: Schematics for battery connector, and the power switch

5.10.1 PMIC
Nordic Thingy:91 uses a power management IC (PMIC) as internal power supply. PMIC includes a battery
charger, a fuel gauge and two regulator outputs.

The PMIC has three voltage domain outputs that are used on Nordic Thingy:91:

• VSYS used for the nRF9160 SiP
• One 1.8 V output used as GPIO voltage
• One 3.3 V output used for analog circuitry

The 1.8 V domain supplies the nRF52840, the accelerometers, the environment sensors, and the GPIOs of
the nRF9160. This domain must always be on for Nordic Thingy:91 to work.

The 3.3 V domain supplies the LEDs, the color sensor, the buzzer, the RF switches and the GPS LNA. This
power domain can be powered down to save power when Nordic Thingy:91 is in sleep mode.

Figure 21: PMIC schematic

5.10.2 Current measurement
It is possible to measure the current flowing to nRF9160 and nRF52840 by cutting the short on SB3
(nRF9160) and/or SB4 (nRF52840) and placing an ampere meter between the terminals of P1 (nRF9160)
and terminals of P2 (nRF52840).

4418_1336 v1.0 27



Hardware description

Figure 22: Measuring current to the nRF9160

Figure 23: Measuring current to the nRF52840

Figure 24: Current measurement schematic

5.11 Programming and debugging interface
Nordic Thingy:91 is equipped with one programming and debugging interface connector (P8) that is
shared between the nRF9160 and nRF52840.
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The device to be programmed is selected by the SWD SELECT switch (SW2). The selection of device can
also be controlled by connecting TP28 to 1.8 V or ground.

Figure 25: SWD SELECT switch

The SWD interface of the nRF9160 can also be connected to the nRF52840. The enabling of this
connection is controlled by the nRF52840.

Figure 26: SWD interface and control schematic

5.12 Interface
To enable the user to connect external hardware, Nordic Thingy:91 routes some of the GPIOs to
connectors or test points and transistors to drive higher currents.

5.12.1 N-MOS transistors
For more flexibility, Nordic Thingy:91 is equipped with four N-MOS transistors that can be used to drive
small DC motors or LEDs. The drain and source of the transistors are available on external connectors and
the gate is connected directly to the nRF9160.
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Figure 27: Schematics for the N-MOS transistors

5.12.2 Connectors
In addition to the N-MOS drain and source on P7, power domains and extra GPIOs can be found on
connectors P3-P6.

For more information, see Connector pinouts on page 30.

Figure 28: Nordic Thingy:91 external connectors

Figure 29: Interface connectors

5.12.2.1 Connector pinouts

Pin Signal Description

1 GND Ground

2 VLi-Ion Battery voltage

Table 4: Pinout of connector P3

Pin Signal Description

1 GND Ground

2 1V8 Regulated 1.8 V domain

Table 5: Pinout of connector P4
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Pin Signal Description

1 GND Ground

2 3V3 Regulated 3.3 V domain

Table 6: Pinout of connector P5

Pin Signal Description

1 SPARE1 GPIO of the nRF52840

2 SPARE2 GPIO of the nRF52840

3 SPARE3 GPIO of the nRF52840

4 SPARE4 GPIO of the nRF52840

5 SPARE5 GPIO of the nRF52840

6 SPARE6 GPIO of the nRF52840

Table 7: Pinout of connector P6

Pin Signal Description

1 1V8 Regulated 1.8 V domain

2 GND Ground

3 MOS_1_D Drain of n-channel MOSFET 1

4 MOS_1_S Source of n-channel MOSFET 1

5 MOS_2_D Drain of n-channel MOSFET 2

6 MOS_2_S Source of n-channel MOSFET 2

7 MOS_3_D Drain of n-channel MOSFET 3

8 MOS_3_S Source of n-channel MOSFET 3

9 MOS_4_D Drain of n-channel MOSFET 4

10 MOS_4_S Source of n-channel MOSFET 4

Table 8: Pinout of connector P7

5.12.3 Test points
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Test point Location Signal Description

TP1 Bottom N.A. Reserved

TP2 Bottom RF_SW1 Bit 0 of RF switch control signals

TP3 Bottom RF_SW2 Bit 1 of RF switch control signals

TP4 Bottom RF_SW3 Bit 2 of RF switch control signals

TP5 Bottom N.A. Reserved

TP6 Bottom N.A. Reserved

TP7 Bottom nRF91-P0.10 GPIO of the nRF9160

TP8 Top nRF52-P0.18/RESET GPIO/RESET of the nRF52840

TP9 Top SCL I2C clock line

TP10 Top SDA I2C data line

TP11 Top VBUS' USB voltage before power switch

TP12 Top VBUS USB voltage after power switch

TP13 Top VLi-Ion' Battery voltage before power switch

TP14 Top VLi-Ion Battery voltage after power switch

TP15 Top GND Ground

TP16 Top GND Ground

TP17 Top VSYS Internal power domain of PMIC and
default nRF9160 power supply

TP18 Top 1V8 Regulated 1.8 V domain

TP19 Top 3V3 Regulated 3.3 V domain

TP20 Bottom ADP_PGOOD1 PMIC output status indication pin 1

TP21 Bottom ADP_PGOOD2 PMIC output status indication pin 2

TP22 Bottom ADP_STP Stop the buck regulator switching of
PMIC

TP23 Bottom ADP_RESET PMIC reset output

TP24 Bottom ADP_MR PMIC manual reset input

TP25 Bottom SPARE7 GPIO of the nRF52840

TP26 Bottom SPARE8 GPIO of the nRF52840

TP27 Top SWDIO Programming interface data line

TP28 Top SWDSEL Programming interface target select

TP29 Top SWDCLK Programming interface clock line

TP30 Top D- USB data line

TP31 Top D+ USB data line

TP32 Top nRF91-P0.13/AIN0 Analog/digital GPIO of the nRF9160,
combined with N-MOS1
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Test point Location Signal Description

TP33 Top nRF91-P0.16/AIN3 Analog/digital GPIO of the nRF9160,
combined with N-MOS4

TP34 Top SCK SPI clock line

TP35 Top MOSI SPI master output, slave input data
line

TP36 Top MISO SPI master input, slave output data
line

TP37 Top ADXL372_CS High-G accelerometer chip select line

TP38 Top ADXL362_CS Low-power accelerometer chip select
line

Table 9: Pinout of connector P3

4418_1336 v1.0 33



6 Regulatory notices

The following regulatory notices apply to Nordic Thingy:91.

6.1 FCC regulatory notices

Modification statement
Nordic Semiconductor ASA has not approved any changes or modifications to this device by the user. Any
changes or modifications could void the user’s authority to operate the equipment.

Interference statement
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must accept any interference, including
interference that may cause undesired operation of the device.

Wireless notice
This device complies with FCC radiation exposure limits set forth for an uncontrolled environment and
meets the FCC radio frequency (RF) Exposure Guidelines. This transmitter must not be co-located or
operating in conjunction with any other antenna or transmitter. The antenna should be installed and
operated with minimum distance of 20 cm between the radiator and your body.

FCC Class B digital device notice
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may cause harmful interference
to radio communications. However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is

connected.
• Consult the dealer or an experienced radio/TV technician for help.
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Glossary
DK (Development Kit)

A development platform used for application development.

GPIO
General-Purpose Input/Output

Global Positioning System (GPS)
A satellite-based radio navigation system that provides its users with accurate location and time
information over the globe.

Integrated Development Environment (IDE)
A software application that provides facilities for software development.

Near Field Communication (NFC)
A standards-based short-range wireless connectivity technology that enables two electronic devices
to establish communication by bringing them close to each other.

Personal Unblocking Key (PUK)
A digit sequence required in 3GPP mobile phones to unlock a SIM that has disabled itself after an in
correct personal identification number has been entered multiple times.

Software Development Kit (SDK)
A set of tools used for developing applications for a specific device or operating system.

SEGGER Embedded Studio (SES)
A cross-platform IDE for embedded C/C++ programming with support for Nordic Semiconductor
devices, produced by SEGGER Microcontroller.

Subscriber Identity Module (SIM)
A card used in User Equipment (UE) containing data for subscriber identification.

System in Package (SiP)
A number of integrated circuits, often from different technologies, enclosed in a single module that
performs as a system or subsystem.

System on Chip (SoC)
A microchip that integrates all the necessary electronic circuits and components of a computer or
other electronic systems on a single integrated circuit.

User Equipment (UE)
Any device used by an end-user to communicate. The UE consists of the Mobile Equipment (ME) and
the Universal Integrated Circuit Card (UICC).

Universal Integrated Circuit Card (UICC)
A new generation SIM used in UE for ensuring the integrity and security of personal data.
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Acronyms and abbreviations
These acronyms and abbreviations are used in this document.

DK
Development Kit

GPIO
General-Purpose Input/Output

GPS
Global Positioning System

IDE
Integrated Development Environment

NFC
Near Field Communication

PUK
Personal Unblocking Key

SDK
Software Development Kit

SES
SEGGER Embedded Studio

SIM
Subscriber Identity Module

SiP
System in Package

SoC
System on Chip

UICC
Universal Integrated Circuit Card

4418_1336 v1.0 36



Legal notices
By using this documentation you agree to our terms and conditions of use. Nordic Semiconductor may
change these terms and conditions at any time without notice.

Liability disclaimer
Nordic Semiconductor ASA reserves the right to make changes without further notice to the product to
improve reliability, function, or design. Nordic Semiconductor ASA does not assume any liability arising out
of the application or use of any product or circuits described herein.

Nordic Semiconductor ASA does not give any representations or warranties, expressed or implied, as to
the accuracy or completeness of such information and shall have no liability for the consequences of use
of such information. If there are any discrepancies, ambiguities or conflicts in Nordic Semiconductor’s
documentation, the Product Specification prevails.

Nordic Semiconductor ASA reserves the right to make corrections, enhancements, and other changes to
this document without notice.

Life support applications
Nordic Semiconductor products are not designed for use in life support appliances, devices, or systems
where malfunction of these products can reasonably be expected to result in personal injury.

Nordic Semiconductor ASA customers using or selling these products for use in such applications do so
at their own risk and agree to fully indemnify Nordic Semiconductor ASA for any damages resulting from
such improper use or sale.

RoHS and REACH statement
Complete hazardous substance reports, material composition reports and latest version of Nordic's REACH
statement can be found on our website www.nordicsemi.com.

Trademarks
All trademarks, service marks, trade names, product names, and logos appearing in this documentation
are the property of their respective owners.

Copyright notice
© 2019 Nordic Semiconductor ASA. All rights are reserved. Reproduction in whole or in part is prohibited
without the prior written permission of the copyright holder.
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